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Introduction 
 

Congratulations and thank you for buying a Sony Ericsson EDGE PC Card. EDGE PC Cards 
are standard size type II PC cards, they enable laptop users to have mobile access to the 
internet or corporate network with flexibility and high speed, including ‘always online’ 
capability via GPRS/ EDGE. The EDGE PC Card is very simple to install and use; the 
software provided allows you to select the best data service available so that the EDGE PC 
Card is always available for data transfer.  

 

Edge PC Card 

 

Band (MHz)  

 

 
 
Regions supported 

GC82 

 

 
850/1900  

 
 
This efficient dual band EDGE PC Card is primarily 
for the North American market, but it can be used 
anywhere GSM 850/1900 MHz Networks are 
available.  

 
GC83  

850/1900  
The triple band GC83 will be available in the 
American markets and will give roaming possibilities 
for travellers to Europe and Asia.  

GC85 

 

 
 

 
900/1800/1900 
 

The triple band GC85 provides global coverage in 
all five continents. GC85 will be available in the 
European and Asia Pacific markets.  
 

 
The triple band GC85 provides global coverage in all five continents. GC85 will be available 
in the European and Asia Pacific markets.  

 
The EDGE PC Card enables your laptop PC to:  

• Browse the Internet  
• Send and receive e-mails  
• Receive information services in real time  
• Access files, databases and discussion groups  
• Send and receive SMS text messages  
• Edit SIM card entries  

 
Note:  
Before using your EDGE PC Card you MUST read Guidelines for Safe and 
Efficient Use on page 42.  
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Hardware Overview  

The GC82, GC83 and GC85 are standard type II Cardbus PC card. The card is standard 
length and only the antenna protrudes outside the PC card slot.  

The amount of power drawn from the laptop battery is dependant upon a number of 
factors including status, distance to the base station and number of timeslots used. See 
Technical Specifications on page 45 for a general guide to power consumption.  

Before using the Edge PC card, you must install the software on your computer and 
assemble the components packaged with the phone, see EDGE PC Card Hardware Set 
Up on page 4.  

SIM Card  

When you subscribe to a mobile network operator, you are issued with a SIM card 
(Subscriber Identity Module card). The SIM contains your personal subscriber data. You 
need to insert a SIM into your EDGE PC Card before it will work.  

Software Overview  
Wireless Manager  
You can use the Wireless Manager to:  

• Display GC82, GC83 or GC85 status information  
• Create or modify connection settings  
• Connect to the Internet or a corporate network  
• Manage EDGE PC Card settings  
• Manage SIM card and PC phone books  
• Send and receive SMS messages  
 

Using the EDGE PC Card with your Applications  

Data Programs  
You can use the EDGE PC Card as a modem to provide Intranet/Internet connectivity 
for a wide range of applications.  

Documentation  

The EDGE PC Card’s documentation is designed to enhance your understanding of its 
capabilities. The following guides are provided:  

• A printed Quick Start Guide aimed at getting you operational as quickly as possible.  
• An online User’s Guide (this document) containing a comprehensive description of the 
EDGE PC Card functionality. You can read the guide on the computer screen or print it onto 
either European A4 or American Letter sized paper.  
 
The User’s Guide is located on EDGE PC Card CD-ROM as Adobe Acrobat PDF files. The 

EDGE PC Card CD-ROM also contains Adobe Acrobat Reader
®
 which you can install if 

necessary.  

Illustrations  
The illustrations in this manual were obtained using the EDGE PC Card on a Microsoft 

Windows
® 

2000 operating system. The dialogs that appear on your PC may differ depending 

on the version of Windows
®
 in use.  
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Getting Started  

Checklist  

Make sure the following items are in the box when you unpack it:  

• Aluminium protective case for storing the EDGE PC Card and its antenna  
• GC82, GC83 or GC85 PC Card  
• Antenna  
• Quick Start Guide  
• CD-ROM The CD contains; drivers, software, documentation and a readme file  
 

System Requirements  

This section lists the network subscriptions, hardware and software requirements for 
running the EDGE PC Card.  

Network and Subscription  
The network subscription you use in conjunction with your EDGE PC Card depends on the 
functions and features your network operator can provide. Contact your network operator or 
service provider to make sure the options you require are available. Make sure that data 
options are included in your subscription, as these are usually optional services.  

Note:  
Mobile operators often provide a number of connectivity options via GPRS such as 
WAP and Internet. Verify the service you require, such as Internet, email or corporate 
VPN (Virtual Private Network) service is available through your mobile operator and 
enabled on your subscription.  

The functionality of the different subscriptions available from networks operators are 
discussed below:  

Circuit Switched Data (CSD)  
CSD is the original GSM network data transfer method, used in the past for WAP. Almost all 
GSM networks have this capability at 9.6 kbps. It is possible for the network to upgrade the 
speed to  
14.4 kbps. The EDGE PC Card operates at this higher speed where available.  

General Packet Radio Service (GPRS)  
GPRS is a type of network connection which provides “always on” mobility. The connection 
set up is fast and, once connected, applications may send and receive data whenever 
required. In today’s GPRS networks, the EDGE PC Card receives data at speeds up to 53.6 
kbps and transmits at speeds up to 26.8 kbps.  
 
Enhanced Data Rates for Global Evolution (EDGE)  
EDGE enhances GPRS by increasing data throughput by a factor of 3. GPRS networks 
enhanced with EDGE are often referred to as E-GPRS (Enhanced GPRS) networks. EDGE 
provides the “always on” capability of GPRS but at faster speeds. EDGE technology is 
transparent, simply make a GPRS connection as usual and benefit from the increase in 
speed where EDGE is available in a network.  

Short Message Service (SMS)  
The PC can send and receive SMS text messages using the SMS Messages screen in the 
Wireless Manager, see Wireless Manager SMS Messages Screen on page 28, for more 
details.  
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Hardware  
You will need:  

•  A PC that has the minimum specification recommended by Microsoft to run the version of                 
Windows® installed on it.  

• A 16 bit type II PC Card slot.  
• A Sony Ericsson EDGE PC Card (GC82, GC83 or GC85).  
• A SIM card.  

 
Software  

You will need:  

• Windows
®
 98SE, Me, 2000 (SP4) or XP.  

• Sony Ericsson Wireless Manager CD-ROM.  
 

Note:  
The Wireless Manager can be downloaded from the Sony Ericsson website, details 
are given below.  

Services Available Over the Internet  

The Sony Ericsson web site contains support to facilitate easy communications and rapid 
information retrieval, wherever you are. It gives you access to on-line customer services, on-
line user manuals, software downloads, and useful information. The address is:  

http://www.SonyEricsson.com/support 

Sony Ericsson’s home page address is:  

http://www.SonyEricsson.com 
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Installation 
 

The Wireless Manager CD-ROM contains the software required to operate your EDGE PC 
Card. The software is simple to set up and operate, but before you begin you will need to 
make sure that the services you require are included on your SIM card subscription. For an 
explanation of the services that are available see Network and Subscription on page 2. 
Contact the organization that supplied you with your SIM card and request that the specific 
services (EDGE, GPRS, CSD or SMS) you require are added to your subscription.  

 
The CD-ROM contains the following software:  
• Wireless Manager  
• User Documentation  
• On-line Help  
• ReadMe text file containing the latest information about the EDGE PC Card  

 
EDGE PC Card Hardware Set Up  

1 Collect your EDGE PC Card, antenna and SIM card together.  
2 Insert your SIM card into the slot on the back of EDGE PC Card, with the gold contacts 

facing downwards.  
 

Note:  
The cut corner of the SIM card must be placed into the PC card as demonstrated 
below, the gold contacts should face downwards.  

3. Connect the antenna to the end of the EDGE PC Card.  

 

If the antenna obstructs the use of your keyboard, try turning it to a horizontal position for 
better service.  

To use the PCMCIA slot for another device, remove the EDGE card as instructed in Safe 
Removal of the EDGE PC Card on page 8, then insert the other device.  

When the EDGE PC Card isn't in use it is recommended that you store it in the protective 
carrier box provided. The unit, especially the antenna could be damaged if it remains in PC.  

Important!  
Do not insert the card into the laptop until you have installed the software from the 
CD-ROM. Simply cancel the New Hardware wizard if the card is accidentally 
inserted prior to software installation.  
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Installing the Software  

1) Insert the EDGE PC Card CD-ROM in your CD drive. 

Note: 
If the CD-ROM does not autorun, select Start Run and type D:\Setup.exe into the 
Run dialog. (Where D is your CD drive.)  

2) The Wireless Manager is installed in the same language as your Windows installation, or 
English if your Windows language is not available. See Supported Languages on page 51 
for more details.  

 
Note: 
If the CD-ROM does not autorun, select Start Run and type D:\Setup.exe into the 
Run dialog. (Where D is your CD drive.)  

3) The InstallShield Wizard for Sony Ericsson Wireless Manager opens; follow the 
instructions on screen. When installation is complete click Finish.  

 
4) Insert the EDGE PC Card. Make sure the EDGE PC Card is fully inserted.  

 
5)  
6) After a few seconds, the New Hardware Wizard opens and installs the necessary drivers 

onto your PC from the EDGE PC Card CD. The wizard may require you to locate a 
specific driver file. If this happens a dialog opens, click Browse and select:  

 
 

 

 

Component  

 

 
EDGE PC Card CD-

ROM Location 

EDGE PC Card Drivers on a Windows 98SE or ME machine   
D:\Driver\Driver9x  

 

EDGE/GPRS Drivers on a Windows 2000/XP machine  D:\Driver\Driver2k 

In the above table D is referred to as your CD drive.  
Note:  
When installing on Windows 98SE, Windows may prompt for the original 
Windows 98 CDROM to be inserted. If the CD-ROM is not inserted when 
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requested, Windows will subsequently reboot with error messages relating to 
missing files. Therefore, it is strongly recommended that the Windows 98SE CD-
ROM is available before installation starts.  

Select the driver file requested by the Wizard and click Open. The Hardware Wizard 
finishes the installation.  

6. Select Programs   Sony Ericsson   Wireless Manager to start using your EDGE PC 
Card.  

7. The EDGE PC Card and Wireless Manager are ready for use.  

Note:  
If you are prompted to reboot the laptop during software installation, you may find that 
the Wireless Manager attempts to start before all of the drivers are installed. The 
reason this occurs is the New Hardware Wizard is still busy installing the 3 device 
drivers. The Wireless Manager splash screen appears, followed by a warning dialog 
saying “You must have a EDGE PC Card Wireless Modem installed to run this 
application. Please install a EDGE PC Card Wireless Modem and try again”. If this 
occurs:  
1.  Click Ok.  
2.  Wait for the New Hardware Wizard to complete the driver installation.  
3.  Reboot the laptop.  
4.  Start the Wireless Manager using the icon on the desktop or via Programs   Sony 

Ericsson   Wireless Manager.  
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Start Using Wireless Manager 

 

1) To start Wireless Manager select Start   Programs    

Sony Ericsson   Wireless Manager or select your desktop shortcut  .  
 
2) If requested, enter your SIM Card/Phone Lock PIN and click OK. It is only necessary to 

enter the PIN number once during a PC session. You are allowed three attempts to enter 
the correct PIN code. If you fail to enter the SIM PIN correctly it is blocked and if you fail 
to enter the Phone Lock PIN correctly your EDGE PC Card is locked. Contact your 
network operator for an unblock code (PUK). Enter the unblock code into the Card 
Blocked dialog and enter a new PIN code and confirm it.  

 

        To set the SIM Card PIN and Phone Lock PIN, see Locks on page 23.  

 
3) The Radio dialog opens, select the required state for your EDGE PC Card radio 

transmission. See Wireless Manager Preferences on page 10 for more details.  
 
4) The Wireless Manager opens, displaying the Status screen. Connectivity details are 

displayed on this screen, the current signal strength and GPRS availability should be 
listed. See Wireless Manager Status Screen on page 20, for more details.  

 
5) The Wireless Manager Icon is displayed in the system tray of your PC.  

 
Wireless Manager Icon  

The Wireless Manager Icon shows the current status of the EDGE PC Card, which is 
typically the current network signal strength and the GSM/GPRS/EDGE service status, 
similar to a mobile phone display. If you right click on the Wireless Manager Icon a menu is 
displayed, see The Wireless Manager Icon Menus on page 9 for details on the menu options.  

Place your mouse cursor over the Wireless Manager Icon to display text indicating:  

• GSM or GPRS/EDGE Service availability  
• Network name  
• Connection information  

Three standard Windows
®
 operating system icons also appear in the system tray when the 

EDGE PC Card is inserted in your PC and connected. They are the Sony Ericsson Wireless 
WAN Adapter icon, Dial-up Networking icon and the PC card icon. The icons will appear in 
the following order if you follow Installing the Software on page 5.  

 

 
 

• Making Windows Network Connections Visible The Windows connection icons, displayed 
in the system tray, normally disappear once a connection is made. This means that you 
may not necessarily see an icon corresponding to each of the icons for your GPRS/EDGE 
and CSD. To make the icon visible, follow the steps described below.  

 

• Right click the appropriate icon and select Open Network Connections. 

 12



Alternatively select Start   Settings   Network Connections.  

• A dialog opens displaying all the network and dial-up connections available on your 
PC. Right click the one you want to edit.  

• Click the Show icon in taskbar when connected box. Click OK to close the dialog. 
When you have an active connection use your mouse to hover over the icon to view 
connectivity details.  

 
• PC Card icon Indicates that a PC card is present and allows the user to see certain 

properties and also to stop/remove the card.  

Safe Removal of the EDGE PC Card  
You must stop the EDGE PC Card before attempting to remove it.  

1) Close any active EDGE PC Card Networking Connections.  
2) Exit Wireless Manager.  
3) Click on the PC Card icon. All the currently connected devices are listed. Select Stop 

Sony Ericsson GC82/83/85 EGPRS Modem.  
4) A dialog is displayed telling you it is safe to remove the card.  
5) The EDGE PC Card can now be removed safely.  
 

Important!  
Incorrect removal of the EDGE PC Card can damage the card.  

Wireless Manager Icon Status  
 

The Wireless Manager Icon displays the status of the EDGE PC Card network connection.  

Radio is set to off or the Wireless Manager has disconnected the             
EDGE PC Card  

  The radio transmitter is enabled, but there is no GSM or GPRS service                
available 

 

  The EDGE PC Card has GSM service and indicates a signal strength of 3 
out of 5 bars. CSD and SMS may be used, provided these are supported by 
the subscription. GPRS/EDGE is not available  

 The EDGE PC Card has GSM and GPRS/EDGE service. If EDGE connectivity is 
available there is no visible indication of this in the Wireless Manager  

 Wireless Manager is waiting for the EDGE PC Card to be inserted  
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The Wireless Manager Icon Menus  

Right click one of the following icons to see the EDGE PC Card GPRS/EDGE menu options.  

 
 

Note:  
Some of these menu options are disabled, depending on the current state of the 
EDGE PC Card.  

Note:  
EDGE capability is not indicated by the EDGE PC Card GPRS/EDGE icons.  

The Wireless Manager Icon menu options are described below.  

Open Wireless Manager  
Select Open Wireless Manager or double click on the Wireless Manager icon to open the 
Wireless Manager.  

Radio Status  
This menu option is dynamic. It monitors the current state of the EDGE PC Card radio 
transmitter and gives you the option to switch to the opposite state, for example, if your 
EDGE PC Card Radio transmitter is on the menu option reads Turn Radio Off.  

You can also set the status of the radio transmitter by selecting Turn Radio On/Off in the 
Wireless Manager menu.  

Connect/Disconnect  
If you are disconnected the menu gives you the option to connect with the last EDGE PC 
Card used. If you are connected the menu gives you the option to disconnect.  

Help  
Opens the Wireless Manager Online Help. You can also launch the Online Help from the 
Wireless Manager Help Menu. Pressing F1 in any of the Wireless Manager dialogs opens 
the relevant help screen.  

About  
Displays a dialog that contains Wireless Manager software information.  

Hide to Tray  
Select the Hide to Tray option to close the Wireless Manager window, leaving only the 
Wireless Manager Icon visible in the system tray. Use the Open Wireless Manager to view 
the software again.  
 
Exit  
Closes the Wireless Manager application, the Wireless Manager Icon will remain in the 

system tray if you have set it to run in the background. See Wireless Manager Preferences 

below for more details.  
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Wireless Manager Preferences  

You can change the general behavior of the Wireless Manager by selecting specific options 

in the Preferences... dialog.  

1. From the File menu, select Preferences. The Preferences dialog opens, 
the Radio Power tab is displayed. 

 

Radio Power Tab  
You can use this tab to manage the state of the radio transmitter.  

Enable Radio immediately You should normally leave this checkbox turned off. 
When  

when card inserted enabled, the Windows driver turns the radio 
transmitter on  
when the card is inserted and leaves it enabled 
even when  
the card is not in use. You should check this option 
if your  
Windows logon requires you to log on using a dial-
up  
connection, see Windows Log on Using 
GPRS/EDGE  
Dial-up Connection on page 14 for more details. 
When  
you click OK to activate this option the Wireless 
Manager  
displays the following dialog.  

 

 
When this option is selected, the Wireless Manager radio 
power startup and shutdown choices are disabled.  

 
The radio mode you specify at Wireless Manager start-up appears selected on the Radio 
tab.  

On When the Wireless Manager is running in radio on 
mode it is registered to the network connections 
can be made and SMS sent and received. The 
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radio can be enabled in several ways;  
• Select Radio On when the Wireless Manager starts.  
• Specify the required radio state in Preferences Radio 

Power.  
See Wireless Manager Preferences on page 10 for 
more details.  

Off Radio Off indicates that the EDGE PC Card will 
not register to the mobile network. You may 
perform non-communication related activities 
such as phone book maintenance, but you must 
turn on the radio in order to make a connection or 
to send/receive SMS.  

 
Ask Me Triggers a dialog to be displayed every time the 

PC is turned on. The dialog asks you if the radio 
transmitter should be turned on or off during the 
active PC session. This is also called Aeroplane 
mode, because it prevents the radio transmitter 
automatically turning on. This is a useful feature in 
areas where radio transmitters are not allowed; 
aircrafts, hospitals or blasting areas.  

Turn Radio Off At shutdown the radio is turned off.  

Reset card Turns the radio off and resets the card.  

Text Messaging Tab  
You can use this tab to enable reception of specific message classes from the SMS Cell 
Broadcast service and to set the SMS received audio alarm to on or off. Select the radio 
buttons to activate the options.  

Example of SMS Cell Broadcast message types:  

Code: Cell Broadcast Message  
000 Index 
010 News Flashes 
020 Hospitals 
030 Long-distance road reports 
040 Weather 
 

To enter multiple SMS Cell Broadcast message types separate each entry with a 
comma, for  
example: 000, 034, 076.  

Note:  
SMS Cell Broadcast message types are network operator specific. Contact your 
network  
operator for more details.  

This screen also allows you to set a validity period for the SMS messages that you are 
sending. For example, if a message you send cannot be delivered because the recipient 
doesn't have their phone on, the validity period sets a time limit on how long the service 
center should keep attempting delivery.  

 
Notifications Tab  

Click the Notifications tab. From here you can decide if you want to:  

 display a splash screen every time Wireless Manager is opened.  
 display a splash screen every time Wireless Manager is closed.  

 display a program end confirmation box. 
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Select the check box to activate the options. 

 

GPRS Connection Tab  

Establish GPRS connection at startup  
Select this option to automatically connect to your chosen network when Wireless Manager 
is  
started. Wireless Manager waits until GPRS is registered and then it establishes the 
specified GPRS  
connection. 
 

Simply select the name of the connection to be established from the drop down list. 
To automatically connect when you start or restart your PC see the example below. If you 
need to 
connect at Windows log on see Windows Log on Using GPRS/EDGE Dial-up Connection 
on page 14. 
 

Example:  If you want your EDGE PC Card to be available and a GPRS internet connection 
to be automatically established when you boot your laptop:  
- Set Preferences  Miscellaneous  Run this program when Windows Starts - Set 
Preferences  GPRS Connection  Establish GPRS Connection At Startup and select 
the GPRS connection required.  

 
Miscellaneous Tab  

Click the Miscellaneous tab. 

 
• Hide to tray when minimized If enabled, when the Wireless Manager is minimized, it 

removes any window from the taskbar, and only shows the small icon in the system tray. 
To re-open the main window, double-click the tray icon, or select open from the icon menu.  

• Run this program when Windows starts If enabled, the Wireless Manager starts when 
Windows is started. If an EDGE PC Card is detected, the Wireless Manager runs. If not, the 
program closes (and runs in the background if permitted). When used with Establish GPRS 
connection at startup, this allows a GPRS session to be automatically connected when the 
user logs on, see Windows Log on Using GPRS/EDGE Dialup Connection on page 14 for 
more details.  

• Minimize when Windows starts If enabled, the Wireless Manager starts when a user logs 
on to Windows, it appears as an icon in the task bar only. If an EDGE PC Card is detected, 
the Wireless Manager runs and connects. If not, the program closes (and runs in the 
background if permitted).  

• • Allow this program to run in the background If enabled, the Wireless Manager runs in the 
background, waiting for a EDGE PC Card to be inserted. When the card is detected, the 
Wireless Manager automatically opens and begins normal operations. When the close box, 
or File   

•  Exit is selected, the Wireless Manager closes but does not exit.  
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It releases control of the card, so it may be stopped and removed, and runs in the 
background.  
You can start the program again from the Start menu, double-clicking the system tray icon, 
or 
by re-inserting the EDGE PC Card. 
You can stop Wireless Manager running in the background by right clicking on the PC 
screen 
and selecting Exit.  
If you attempt to start Wireless Manager with no EDGE PC Card inserted a warning dialog 
is 
displayed, informing you that the EDGE PC Card is not present, and Wireless Manager 
switches  
back to background mode. 
 

• Hide tray icon when no card inserted If this option is selected, Wireless Manager runs in 
background mode, the Wireless Manager icon is not displayed in the system tray. If the 
card is inserted, the icon reappears and the Wireless Manager is started.  

• • Show menu item for Modem Software Update If this option is checked, a File Modem 
Software Update... menu item is enabled. Selecting this menu command prepares the 
modem to receive a software update from the Sony Ericsson Update Service. More 
information about this service can be found at http://www.sonyericsson.com/support/.  

 
Examples:  If you want to activate your EDGE PC Card when the laptop is booted, so that it 

is ready to make a connection and send/receive SMS: - Set Preferences   
Miscellaneous   Run this program when Windows Starts.  
If you want your EDGE PC Card to be available and a GPRS internet 
connection to be automatically established when you boot your laptop: - Set 
Preferences   Miscellaneous   Run this program when Windows Starts. - 
Set Preferences  GPRS Connections   Establish GPRS Connection At 
Startup. 
-Select the GPRS connection required.If you remove the EDGE PC Card during 
usage and want it to be automatically reactivated when you re-insert it:- Set 
Preferences  Miscellaneous Allow this program to run in the background. 
 
Note: If you have Establish GPRS connection at Startup set, then the 
connection 
will also be automatically established when you insert the card.  
 

If you want to start the laptop with the EDGE PC Card removed and have it 
automatically activated when it is later inserted:  

Set Preferences   Miscellaneous   Run this program when Windows Starts. 
- Set Preferences Miscellaneous Allow this program to run in the 
background.  
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Windows Log on Using GPRS/EDGE Dial-up Connection  

The EDGE PC Card supports the Windows Log on using dial-up connection feature.  

To log on to Windows using a dial-up connection the EDGE PC Card must be inserted and 
the radio enabled before you log on. To enable the radio prior to logon, select Enable radio 
immediately when card inserted checkbox in the Radio Power preferences tab, see Radio 
Power Tab on page 10 for more details.  

Important!  
Never start your PC in this mode if you are in a location where mobile devices 
shouldn’t be used, for example, on an aeroplane, in hospital or near a blast site.  

Only check this option if you need to log on to a Windows Domain via a wireless dial-up 
connection. This will permit the EDGE PC Card to register with the network and establish a 
connection when the Windows logon screen is displayed.  

Note:  
It is not possible to display network status or signal strength during the Windows 
logon procedure, so you should allow enough time for the EDGE PC Card to find and 
register with the wireless network prior to attempting to log on.  

The dial-up connections available to the Windows Logon must have been created by a user 
account with Administrator privilege and designated For all users. This must be done using 
the Windows Network Connection Wizard, because the Wireless Manager can only create 
connections for the current user ID.  

Normally the Windows Logon using dial-up connection will be using a CSD session to a 
corporate network, so that the logon credentials can be validated by a Windows Domain 
Server.  

There may be special circumstances where a GPRS dial-up connection is required for 
logon. To create a GPRS dial-up connection, follow these steps:  

1. Create the Windows dial-up connection using the Windows Network Connection Wizard. 
For the telephone number, use *99***3#.  

2. Set the GPRS context parameters in the EDGE PC Card using the following AT 
commands. Type the AT Commands into the Windows Hyperterminal program.  

 
AT+CGDCONT=3,“IP”,“<AccessPointName>”,“”,0,0 where <AccessPointName> is the 
name of the special GPRS access point for your corporate GPRS service.  
Note:  
In this example, we used GPRS Context 3. There are 10 possible contexts supported by 
the EDGE PC Card (1..10). Context ID 2 is reserved for use by connections created by 
the Wireless Manager. The context definition is stored in nonvolatile memory in the EDGE 
PC card and only needs to be set up once. Cards could be set up, for example, by the IT 
Manager using a different laptop.  

Refer to the AT Command Manual or contact your service provider for further assistance.  
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Create a Connection 
 

Your mobile operator may have entered predefined customised connection settings for you. 
Check the connection drop-down menu for any existing entries, if they are available go 
directly to Using your Connection on page 18.  

1. Click  or select View  Connection Wizard. The Connection Wizard opens.  
2. Select the radio button next to Create a new connection, enter a name, for example 

‘My Connection’, click Next.  

Note:  
Your connection name should not exceed 16 characters for it to be fully visible in 
Wireless Manager.  

3. The Type of Connection dialog opens. From here you select the type of connection you 
require:  

• For GPRS/EDGE see steps 4 to 8  
• For CSD see steps 9 to 12  

 
GPRS/EDGE Connection  

4. Select GPRS/EDGE. Select your Network Operator from the Choose Network drop 
down list. If your Network Operator isn’t listed selected <Other>. Click Next. See 
Network and Subscription on page 2 for more information on GPRS.  

Note:  
Type the first letter of the Network Operator you require into the field to list all the 
operators that start with that letter.  

5. If the Access Point Name dialog opens, check the APN displayed (for some operators 
it is deliberately blank). If you selected <Other> enter the APN for your operator. 
Contact your Network Operator if necessary to find out the correct APN.  

 
6. To modify the selected APN’s settings, Click Advanced.... See Appendix A - 

Connection Parameters on page 59, for descriptions of the updateable parameters in 
the Advanced dialog. The Secondary APN information is only used in special 
customised cases where the information will be filled in for you. Otherwise the tick-box 
must be left un-ticked and secondary APN name blank. Click Apply to save any 
changes before closing the dialog. Click Next.  

 
Note:  
Your connection will automatically switch to EDGE when the network is 
available, allowing your PC Card to work at faster speeds.  

7. If the operator you have selected in step 4 does not require a User ID and Password 
leave this dialog blank if it is displayed. If you have to logon to your service provider, 
enter you User ID and Password into the specific fields. If you want to enter your 
User ID and Password every time you connect tick the box provided. Click Next.  
 
Note:  

Some versions of Windows
® 

deliberately change the number of asterisks that 
represent a password and place asterisks in the password field when the 
password is blank in order to make the display secure.  

8. Click Finish to create your connection or Back to review your settings.  
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CSD Connection  

9. Select CSD. Select your service provider from the Choose Network drop down list. If your 
service provider isn’t listed select <Other> or <North America> depending on your 
location. Click Next.  

10. If you selected a Network Operator from the Choose Network drop down list, the 
telephone number dialog should be automatically filled in. If you selected <Other> or 
<North America> from the Choose Network drop down list; enter the number you need to 
dial to connect to your Network Operator in the Telephone Number field; include your 
country and area code. Ensure Use Area Code and Country Code is deselected.  

 
Note:  
Contact your Network Operator for a telephone number if necessary.  

 

11. Click Advanced.... You can specify your preferred CSD network connection speed from 
the drop down list and the method you want to use to connect to the network, on the 
Speed tab of the Advanced dialog. Click Next.  

Note:  
If you are unsure which speed to choose from the Speed tab, start with Analogue 
9600,and check to see if it works. Once your connection works on Analog, you can try 
the V110/V120 settings. V110/V120 connects faster than analog. When roaming you 
may need to repeat this procedure to adapt your settings to the capability of the  

 

12. Select the Options tab in the Advanced 
dialog to specify a callback number, if 
required. Callback is a service that allows 
the call direction to be reversed. If you want 
to watch the progress of a callback in a 
terminal window click the Show Terminal Window 
After Dialing box.  

 

 See Appendix A - Connection Parameters on page 59, for descriptions of the 
updateable parameters in the Advanced dialog. Click Apply to save any changes 
before closing the dialog.  

13.  If you need a User ID and Password to logon to your service provider enter them into the 
specific fields. If you don’t need a username and password leave the fields blank. Click 
Next.  

 
Note:  

Some versions of Windows
®
 deliberately change the number of asterisks that 

represent a password and place asterisks in the password field when the password 
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is blank in order to make the display secure.  

14. Click Finish to create your connection or Back to review your settings.  

Modify a Connection  

1 Select Modify a Connection. The Select a Connection drop down menu is activated. Click 
on the menu and select the connection you want to modify.  

2 Click Next.  
3 Change settings as required.  
 

Delete a Connection  

1 Select Delete a Connection. The Select a Connection drop down menu is activated. Click 
on the menu and select the connection you want to delete.  

2 Click Next. The Success dialog is displayed. Click Finish to close the Connection Wizard.  
 
Using your Connection  

To Connect  
1 Open Wireless Manager.  
2 If requested enter your SIM Card PIN and click OK. The Status screen is displayed.  
3 Select the connection you require from the drop down list and click Connect. If requested 

enter your User ID and Password.  
 

To disconnect an active connection  

1. Click Disconnect on the Status screen. 

The Wireless Manager ends the connection. 

Alternatively: 

Right click on the Wireless Manager icon in the system tray and select Disconnect. 

 
Note:  
You can also use the Preferences dialog to set up auto connection when the 
Wireless Manager is opened. See Wireless Manager Preferences on page 10 for 
more details.  

Browse the Internet  

You can connect to the Internet using a CSD or GPRS/EDGE connection:  

1 Open your preferred connection from the Status screen. See Using your Connection on 
page 18 for details on opening a connection.  

2 Start your Internet browser. You are online and can browse the Internet.  
 
Send and Receive emails  

You will need an email program installed on your PC in order to send and receive emails. 
You can send and receive emails using a CSD or GPRS/EDGE connection:  

1 Open your preferred connection from the Status screen. See Connection on page 21 for 
details on opening a connection.  

2 Start your email program. You are online and can send and receive emails.  
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Wireless Manager Status Screen 
 

The Status Screen is displayed when Wireless Manager opens. You can also open  

the Status screen by clicking   or selecting View  Status.  

 

The Status screen shows detailed SIM card and network status information. The left side of 

the screen shows graphical icons, representing:  
• Receive signal strength  
• GPRS/EDGE service status  

• Unread SMS Text Message SMS  status (or SIM Full indication  ). 
See Wireless Manager SMS Messages Screen on page 28 for more details.  

• Connection status  

The left side of the screen also displays:  
• The current Network Status, e.g. searching, radio off  
• The connection progress messages  
 
The right side of the Status screen displays connection details. When a connection is 
established, the connection statistics (duration, bytes transmitted, bytes received) are 
displayed and updated at regular intervals.  

Note:  
Statistics display is not supported on Window 98(SE) or Me platforms. To view statistic 
data when using these operating systems hover your mouse cursor over the standard 
Windows Dial-up Networking icon.  

 

Connection  

To connect, cancel or disconnect a GPRS/EDGE or CSD data 
session use the Connect/Disconnect drop down menu. The 
menu displays all the connections you have defined, so you 
can quickly select the required connection.  

The Connect/Disconnect button, located underneath the drop 
down menu, changes it’s appearance depending on the state 
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of the EDGE PC Card connection. The button allows you to:  

• Initiate a connection (Connect)  
• Cancel connection attempt (Cancel)  

• Disconnect (Hang-up) an existing session  

To create a connection see Create a Connection on page 16.  

Note:  
You can also launch or terminate a CSD dialup networking sessions directly from the 
Windows Network Connections icon.  
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Wireless Manager Telephony Settings Screen 

 

The Telephony Settings screen allows you view and change the GSM settings of the EDGE 
PC Card.  

The functions of the Telephony Settings screen are very similar to the settings that you have 
access to via a mobile phone’s display.  

Note:  
Your EDGE PC Card has to be inserted into your computer to make changes to the settings.  

1. Click or select View   Telephony Settings.  

 
The window is divided into two areas: the navigation area on the left and the information area 
on the right.  

When you have selected a setting in the navigation area, Wireless Manager retrieves the 
current setting information from the EDGE PC Card and displays the information in the 
right area.  

Phone Numbers  

My numbers  
You can list all your own numbers here. The numbers are for personal reference only and 
have no operational effect on the EDGE PC Card.  

Voice line 1 and 2:  
The voice number or numbers issued with your SIM card that you use for normal voice 
calls. If you have line 2 (alternate line service) enter in the Voice Line 2 number field.  
Data:  

 25



The number used to make a data call to the EDGE PC Card (Mobile Terminated).  

Fax:  

Fax is not supported by the EDGE PC Card.  

SMS Service Centre  
When you send a text message it goes to your operator's service centre, they then forward 
it to the correct recipient. The SMS service centre is identified by a telephone number.  

Note:  
The SMS Service Centre number is normally read automatically from your SIM card.  

To Set or change the service centre address:  

1 Enter your operator's service centre phone number in the Number text box.  
2 Click Apply to transfer the setting to your EDGE PC Card.  
 
Locks  

Phone lock  
The phone lock protects the EDGE PC Card against unauthorized use if it is stolen and 
used with another SIM card. Phone Lock is not activated when you buy the EDGE PC 
Card.  

You can use this screen to change the default security code (0000) to any four to eight 
digit personalized code.  

You can set the Phone Lock Status to one of the following states:  

• On - A brief message Phone lock is displayed each time you turn on the computer. The 
Enter phone lock code dialog opens. Enter your code into the dialog and click OK.  

• Off - The EDGE PC Card is not locked.  
• Automatic - If the Automatic setting is selected, the message Phone lock only appears 

when a different SIM card is inserted into the EDGE PC Card. After the security code has 
been entered correctly, the EDGE PC Card can be used with the new SIM card.  

 
Note:  
The Phone Lock code has four to eight digits and is shown as asterisks upon entry 
in the dialog.  

To Change the Phone Lock code:  

 
2. The Change the Phone Lock Code dialog opens. Make the required changes and click 

OK.  
3. Click Apply when you have finished, to transfer the changes back to your EDGE PC Card. 

This may take a few seconds.  
 
SIM lock  

Some SIM cards are protected with a PIN (Personal Identity Number) at the time of 
purchase. If the SIM card lock is activated, you have to enter the PIN  every time you turn on 
your PC and open Wireless Manager. If you enter your PIN incorrectly three times in 
succession, the SIM card is blocked and you need a PUK code, from your network operator, 
to unblock the SIM card.  
• To activate the SIM card lock, select the On radio button.  

Caution!  
Only activate the SIM card lock if you know the PIN code.  

• To cancel the SIM card lock, select the Off radio button.  

Note:  
You have to use your PIN code to turn the SIM card lock off.  
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To Change the PIN Code:  

 
1 Enter your old PIN code, followed by your new four to eight digit PIN code. Confirm the new code 
by entering it again.  
2 Click OK.  

 
Note:  
The SIM card lock only protects your subscription and not your EDGE PC Card from 
unauthorized use. If you change your SIM card, the EDGE PC Card will still work with 
a new SIM card.  

4. Click Apply when you have finished to transfer the changes back to your EDGE PC Card. 
This may take a few seconds.  
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Networks  

Current Network  
You can select which network you want to use by going to Networks and then choosing 
Current Network.  

Searching for the available networks:  
• Click Retrieve, the current network appears in the box with all the other currently available 

networks.  
The available networks will fall into one of the following three categories:  
• The home network.  
• Available networks, networks that your home mobile operator has a roaming agreement 

with.  
• Forbidden networks, you can’t use these networks except for emergency calls. If your 

home network and a forbidden network come to an agreement that allows you to use the 
forbidden network, you can select this network even though it is forbidden.  

 
Choosing another network:  

1 Uncheck Automatically choose a network for me.  
2 Select the network that you want to use.  
3 Click Apply to transfer the setting to your EDGE PC Card.  
 

The message Please wait appears briefly on the screen. If you are not allowed to use the 
network that you have chosen, Forbidden is displayed.  

Note: GPRS is commonly available in GSM networks, but fewer roaming agreements are 
in place. You may therefore need to explicitly select one of the available networks in order 
to use GPRS when abroad. Check with your home operator to find out which networks 
are GPRS roaming partners in the country or region in which you want to roam.  

Preferred Network  

Note:  
This option is only available if your operator provides it.  

A list of preferred networks is stored on the SIM card. This is typically set up by your mobile 
operator as part of SIM manufacture. Preferred roaming partners are placed in the list so that 
you have the greatest range of available services when roaming. When the home network is 
not available, the EDGE PC Card will check the available networks against the preferred 
network list and select the one placed highest. Automatic network selection must be enabled.  

If you want to add a new network:  
1 Click Add, a new dialog with all the networks known to the EDGE PC Card appears on the 
screen.  
2 Select the network that you want to add and click OK.  
3 Click Apply to transfer the setting to your EDGE PC Card SIM card. If you want to delete a 
network from the list:  

If you want to delete a network from the list: 
1 Select the network that you want to delete.  
2 Click Remove.  
3 Click Apply to transfer the setting to your EDGE PC Card’s SIM card. If you want to re-arrange 
the order of the networks listed:  

If you want to re-arrange the order of the networks listed: 
1 Select the network that you want to move.  
2 Click the Move Up or Move Down arrows to rearrange the order.  
3 Click Apply to transfer the setting to your EDGE PC Card’s SIM card.  
 

Note:  
If the list of preferred networks is full, the Add button is disabled (grey).  
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Wireless Manager SMS Messages Screen 

 

The Wireless Manager’s SMS Messages screen enables you to view, compose, edit, save, 
copy, delete, reply or forward SMS messages from your EDGE PC Card to other mobile 
devices.  
 

Note: To use Message functionality SMS must be included in your subscription, contact 
your network operator for more details.  

 
The SMS Messages screen is split in to a left and right area. 

The left area displays the folders; SIM SMS, Saved Messages, Sent Items and Unsent 

Items. 

The right area displays the contents of the selected folder. The top half of the right pane 

displays a list of received messages, sorted by date and the bottom half of the screen 

displays the content of a selected messages, this is referred to as the Information View. 

 

The folders and their names are static, therefore you cannot change them. 

 

     Click to display the contents of the SIM Inbox. When Wireless Manager is opened  
any new SMS in the SIM Inbox are uploaded to the PC automatically.  
A status flag indicates whether a message is read or unread.  
If a new SMS arrives when the Wireless Manager is open  SMS is displayed on the 
Status screen and the SMS audio sound is played, if enabled in the Setting dialog. 
See Wireless Manager Preferences on page 10.  

 

 If you want to keep an SMS, use the copy or move menu options to place it in the 
Saved folder. Click on the folder icon to display the contents of the Saved folder. 

     A copy of each SMS that you have sent is stored in this folder. Click on the                                         
folder icon to display them 

    Any composed messages that have not been sent are displayed when you click on 
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 this icon.  
           SMS stored in this folder can be edited or sent when the EDGE PC Card is inserted. 
           Any SMS message that fail during transmission are also stored here; you can resend  

 them at any time. 
 

Each time the SMS Messages screen receives a new SMS message from the SIM it checks 
the status of the SIM Inbox. If the SIM Inbox is full, a SIM Full icon is displayed in the left 
pane of the screen, see SIM Inbox is Full: on page 31.  

Note:  
For all the SMS Messages screen menu options to operate the EDGE PC Card 
must be registered successfully on a network. You must have a GSM signal to 
Send SMS, the button is disabled (grey) if you don’t have a signal.  

Class 0 messages  
If you receive a Class 0 message, it will appear in a pop-up dialog, which you can save or 
dismiss. If you choose to save the message it will be stored in you Saved Messages folder.  

SMS Manager Functionality  

To Send an SMS:  
1 Select Create New Message... from the Messages menu or click  .  

2. The New Message dialog opens.  
3. Enter the recipient’s mobile phone number in the To: field or select a number from a 

phone book by clicking Lookup... To send an SMS to multiple numbers, hold down Ctrl 
when selecting the numbers from the phone book.  

4. Type your message into the Message: field.  
5. If required you can click the Calculate SMS blocks to see how many SMSs your message 

will be split into. Also you can check the Request Status Report to get confirmation when 
the SMS arrives at its destination (if this service is supported by your network).  

6. Click Send to send the SMS or Cancel to close the dialog without sending the SMS.  
 
To Edit a Message:  

When you are working with a message, you can edit the text by cutting, copying and pasting.  

Moving Text:  
1 Select the text you want to move (the text can be in another PC application).  
2 Select Cut from the Edit menu or Ctrl and X on the keyboard.  
3 Place the cursor where you want to insert the text and select Paste from the Edit menu or Ctrl and 
V on the keyboard.  
 

Note:  
If you want to copy text, select Copy (Ctrl and C) from the Edit menu instead of Cut 
(Ctrl and X).  

Reply to an SMS:  
1 Select the folder where the message is located.  
2 From the list, select the message to which you wish to reply. The contents of the message are 
displayed in the information view.  
3 Select Reply in the Messages menu. A dialogue appears. The To: field is automatically filled in 
and the original message is displayed in the Message: field.  
4 If required you can click the Calculate SMS blocks to see how many SMSs your message will be 
split into. Also you can check the Request Status Report to get confirmation when the SMS arrives at its 
destination.  
5 Type your reply and click Send.  
 
To Forward an SMS:  
1 Select the folder where the message is located.  
2 From the list, select the message you want to forward. The contents of the message are 
displayed in the information view.  
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3 Select Forward in the Messages menu or click (forward icon), a dialogue box opens.  
4 Enter the phone number in the To: field or click Lookup... to select a number from a phone book. 
To send an SMS to multiple numbers, hold down Ctrl when selecting the numbers from the phone book.  
5 If required you can click the Calculate SMS blocks to see how many SMSs your message will be 
split into. Also you can check the Request Status Report to get confirmation when the SMS arrives at its 
destination.  
6 Click Send.  
 
Delete an SMS:  
1 Select the folder where the message is located.  
2 From the list, select the message you want to delete. The contents of the message are displayed 
in the information view.  
3 Select Delete from the Edit menu, or press the Delete button on your keyboard.  
4 A confirmation message box opens, click Yes to delete the message.  
 

Note:  
To delete all messages, click Select All from the Edit menu before you select Delete.  

Folder Management:  

Sorting SMS:  
1 Select the folder where the messages you want to sort are located.  
2 Click the Date column heading to sort the SMS in ascending or descending date order.  

 
Moving SMS:  

1 Select the folder where the message you want to move is located.  
2 From the list, select the message. The contents of the message are displayed in the information 
view.  
3 Click Move to from the Messages menu. A progress dialog is displayed informing you that the 
SIM card is being updated.  
4 The selected message is moved.  

 
Note:  
To move all messages, click Select All from the Edit menu before you select Move to.  

Copy an SMS:  
1 Select the folder where the message you want to copy is located.  
2 From the list, select the message. The contents of the message are displayed in the information 
view.  
3 Click Copy to from the Messages menu. A progress dialog is displayed informing you that the SIM 
card is being updated.  
4 The selected message is copied.  
 

Note:  
To copy all messages, click Select All from the Edit menu before you select Copy to.  

SIM Inbox is Full:  
When the Wireless Manager detects the SIM SMS storage is full, it displays   on the 
Status screen and in the SMS Messages screen. You must move or delete some SMS 
messages from the SIM Inbox to free storage space so that you can continue receiving new 
SMS messages from the network. To do this you can either:  

• Move your SMS from SIM SMS to Saved Messages  
• Right click on an SMS in SIM SMS and select delete.  
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Wireless Manager Phone Book Screen 
 

The Wireless Manager Phone Book screen helps you to organize your EDGE PC Card’s SIM 
Phone Book.  

The Phone Book Screen  

A SIM Phone Book can easily become disorganized; you can use the Phone Book screen to 
manage your SIM Phone Book entries.  

You can add new numbers, edit existing numbers, export and import entries.  

                    1. Click  to display the Phone Book screen.  

 
2. Icons appear in the left pane representing the SIM Phone Book  and Saved Phone 

Book . You can manage your Phone Book entries by copying entries to the SIM 
Phone Book or the Saved Phone Book.  

3. Click on the icon to display the Phone Book entries in the right pane.  

Note:  
Your EDGE PC Card must be inserted to display this information.  
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Phone Book Functionality  

To Add a Number:  
1. Select Add New in the Phone Book menu or click   on the toolbar or key Ctrl and N.  
2. The New Phone Book Entry dialog opens.  

 

 

3. Enter the name and phone number.  
4. Click OK to save the entry or Cancel to close the dialog.  

 
Note:  
Phone Book numbers are limited to 20 digits (including +) and names are limited 
to 18 alphanumeric characters.  

New entries are added to the next available SIM index position.  

To Modify a number:  
1 Select the number you want to modify.  
2 Select Modify... in the Phone Book menu.  
3 The Edit Phone Book Entry dialog opens.  
4 The fields in the dialog display the current entry’s name and number.  
5 Edit the information.  

6 Click OK to save the entry or Cancel to close the dialog  
If the modified entry is in the SIM Phone Book the changes are automatically sent to the 
SIM.  

 
To Find Entries:  

1 Select Find in the Phone Book menu or key Ctrl and F.  
2 The Find dialog opens. Enter the text or number you want to search for in the Look for field. The 

entry can be complete or incomplete.  
3 Click Find. The Wireless Manager searches both Phone Books; when a match is found it is 

displayed in the right pane. Click Find Next to search again.  
4 Click Close when you have finished searching.  

 
To Copy an Entry:  

1 Select an entry from the SIM Phone Book or the Saved Phone Book.  
2 Select Copy To in the Phone Book menu. The Copy To option is followed by the name of the 

Phone Book you haven’t selected the entry from.  
3 A duplicate entry is made in the specified Phone Book. The new entry is assigned the next 

available position in the destination Phone Book.  
 
To Move an Entry:  

1 Select an entry.  
2 Select Move To in the Phone Book menu. The Move To option is followed by the name of the 

Phone Book you have selected the entry from.  
3 The entry is moved from its current Phone Book and placed in the selected one. The new entry is 

assigned the next available position in the destination Phone Book.  
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To Import an Entry or Phone Book:  

1. Select Import from the Phone Book menu.  

 

 
2. Select the Replace Existing Phone Book or Merge with existing Phone Book radio button.  
3. Click  and browse to find the file you want to import.  

Note:  
The file must be a text file in comma separated value (CSV) format. Any invalid lines 
or files will be ignored.  

4. Click OK in the browse dialog. The path and file name are displayed in the Import File 
Name field.  

5. Click Import to complete the import procedure.  
 
To Export an Entry or Phone Book:  

1. Highlight the entries or open the Phone Book you want to export.  
2. Select Export from the Phone Book menu.  

 

3. Select All to export the entire Phone Book, or Selected Items to export the highlighted 
entries.  

4. Type a name for the file into the Export File Name field.  
5. Click   and identify the save location.  

Note:  
The file will be saved as a text file in comma separated value (CSV) format.  

6. Click OK in the browse dialog. The path and file name are displayed in the Export File 
Name field.  

7. Click Export to complete the procedure.  
 
Delete a number  

1 Select the number that you want to delete.  
2 Select Delete, from the Edit menu.  
3 A confirmation dialog opens, click Yes to delete the number.  

 
Note:  
If you want to delete all numbers, select Select All from the Edit menu before clicking 
Delete.  

To Send a New SMS Message:  
1 Select an entry from a Phone Book.  
2 Select Create New Message from the Messages menu.  
3 A new SMS Message dialog is opened and pre-addressed with the selected entries 

details.  
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Troubleshooting  

This chapter lists some problems that you might encounter while using your EDGE PC Card. 
Some problems require you to contact your service provider, but most of the problems you 
can easily correct yourself.  

Wireless Manager Icon Errors  

 appears 
in the task bar  

Indicates that the Radio is turned off. Right click the CMI, select 
Radio Settings from the sub menu, select On. 

appears in 
the task bar  

Indicates that the EDGE PC Card cannot find a network, there is 
no network within range or the received signal is too weak. You 
have to move to get a stronger signal.  

A signal is 
present but you 
can’t connect to 
the GPRS 
network  

Indicates that a GSM network is present, but no GPRS service is 
available. This can be caused by: no GPRS service in the area, 
you are roaming on a network for which no GPRS roaming 
agreement exists or there is a temporary fault on the network. 
Contact your network operator for more details. 

  appears 
in the task bar  

EDGE PC Card isn't present, please insert.  

 
Software Errors  

Grey text indicates a function that is temporarily unavailable, for 
example due to your subscription or due to a certain setting 
which has not been turned on. 

Grey menu 
options in the 
software 
applications 
 
Error Messages  

General 

Check the radio is turned on.  Modem not 
responding.... 
Error  

Dial-Up fails  Try to connect again.  
 
 
Sim cards errors  
 

Wrong PIN/ 
Wrong PIN2  

You have entered your PIN or PIN2 incorrectly. Enter the correct 
PIN or PIN2, and click OK. See SIM lock on page 23.  

Codes do not 
match  

When you want to change a security code (for example your 
PIN) you have to confirm the new code by entering it again. This 
error occurs when the two codes, that you have entered do not 
match. See Phone lock on page 23.  
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PIN blocked/ 
PIN2 blocked  

You have entered your PIN or PIN2 incorrectly three times in 
succession. To unblock, see SIM lock on page 23.  

PUK blocked – 
contact operator  

You have entered your personal unblocking key code (PUK) 
incorrectly 10 times in succession. Contact your network 
operator or service provider.  

 
 
Error Codes  

Windows
®
 98 

 

An ISDN mode (V110 or V120) has been selected when creating 
a connection, but is not supported by the network. Select 
Analogue mode when creating the connection in the Connection 
Wizard.  

Error 619: The 
port is 
disconnected 
during dial-up  

Telephony settings are set to pulse dialling, change to tone 
dialling. Check the dialling settings for the current location (In 
Control Panel  Phone and Modem Option  Dialling Rules 
Location Edit) and change the Dial using setting to tone, or (if 
Pulse is a necessity), create a new location called EDGE 
Anywhere and set the dialling to Tone. EDGE anywhere location 
should then be used whenever you use the EDGE PC Card.  

Error 629: The 
port was 
disconnected 
by the remote 
machine during 
dial-up  

A Dial-up networking connection is already connected. Close the 
connected dial-up and try again.  

Error 630: The 
port was 
disconnected 
due to hardware 
failure during 
dial-up  

Incorrect APN or CID selected for network. Modify your Dial-up 
Connection, see Create a Connection on page 16 for more 
details. Make sure that the APN file contains the name of the 
access point your network operator is using. The Dialup Wizard 
should do this automatically, if you are experiencing problems 
contact your network operator.  

Error 645: 
Internal 
authentication 
error during 
dial-up  

 
Error 650: Incorrect User ID and/or password. Re enter 

correctly. Remote Access server is not responding during dial-
up  

 

Error 720: The service is not supported by the SIM, 
usually appears when  

PPP control  

you are trying to connect to GPRS Internet. 
Contact service  

protocols  

provider to enable GPRS Internet access on 
SIM card configured during dial-up  
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Windows
®
 2000  

An ISDN mode (V110 or V120) has been selected when creating 
a connection, but is not supported by the network. Select 
Analogue mode when creating the connection in the Connection 
Wizard.  

Error 619: The 
port is 
disconnected 
during dial-up  

The domain name entry is incorrect. Correct the domain name 
entry or delete if not required.  

Error 691: 
Access denied, 
user name and 
password 
incorrect on the 
domain during 
dial-up  

This error indicates a PPP conversation started, but it was 
terminated because the remote server did not respond within an 
appropriate time. This can be caused by poor line quality or a 
problem with the server (ISP). This error can occur when your 
modem has connected to the ISP and has sent a username and 
password, but there is no response from the server. Wait a few 
minutes and try again.  

Error 718: The 
card was 
unable to dial 
during dial-up  

 

All Windows
®
 Operating Systems  

 
Error 734 

 
The PPP link The APN entry is incorrect, the signal is weak or 
the control protocol was connection is lost whilst dialling. 
terminated during dial-up If you are experiencing problems 
contact your network operator and check the APN. 

Error 678 Computer you Either: Service is not supported by SIM 
(usually for CSD) are dialing is not or the computer is not 
answering. responding during dial-up Check SIM settings 
with your service provider if necessary. Make sure that the 
server you are dialing is OK. If you are unsure which speed 
to choose from the Speed tab, start with Analogue 9600, 
and check to see if it works. Once your connection works on 
Analog, you can try the V110/V120 settings to see if faster 
speeds are available. V110/V120 also connects faster than 
analog. When roaming you may need to repeat this 
procedure to adapt your settings to the capability of the 
local network operator.  

 
 

No specific reason for failure is available. Wait a few 
minutes and try again. If you continue to get this error 
check your connection settings or call your service 
provider for help.  

Connection Failed or 
Activation Failed. Please 
contact your Service 
Provider.  

Connection Failed. Invalid 
APN. Please check and 
enter the APN again.  

The APN entry is incorrect, the signal is weak or the 
connection is lost whilst dialing. If you are experiencing 
problems contact your network operator and check the 
APN.  

Connection Failed. Invalid 
User Name or Password. 
Please check and enter the 
User Name and/or 
Password in your 
connection profile.  

Choose to modify your connection in the Connection 
Wizard. Go to the User ID screen and re enter the User 
Name and Password given to you by your service 
provider. If you were not supplied with a User Name and 
Password leave the fields blank. Contact your service 
provider if you continue to have problems.  
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Your service provider doesn't recognise you. Check the 
setting you have entered to create your connection. If 
you still get the error contact your service provider and 
check you have GPRS Internet enabled on your 
subscription and then setting you should enter to create 
a connection.  

Connection Failed. Invalid 
Profile. Please check and 
re-enter your connection 
profile information, and try 
again. If the problem 
continues please contact 
your Service Provider.  

Disconnected from Network  You have been disconnected from the network. Wait a 
few minutes and try again. If the problem persists contact 
your service provider.  

Connection failed. 
Temporary Network 
problem. Please try again. 
If the problem continues 
please contact your Service 
Provider.  

This error indicates a PPP conversation started, but it 
was terminated because the remote server did not 
respond within an appropriate time. This can be caused 
by poor line quality or a problem with the server (ISP). 
This error can occur when your modem has connected to 
the ISP and has sent a username and password, but 
there is no response from the server. Wait a few minutes 
and try again.  

Your service provider doesn't think your authorised to 
access their network. Check the setting you have 
entered to create your connection. If you still get the error 
contact your service provider and check your 
subscription.  

Connection Failed. Not 
authorised to access 
network. Please contact 
your Service Provider.  

Contact your service provider and request the GPRS 
Internet subscription is activated for your SIM.  

Connection Failed. SIM is 
invalid for GPRS service. 
Please contact your 
Service Provider.  

Your service provider is not allowing you to access their 
network. Check the setting you have entered to create 
your connection. If you still get the error contact your 
service provider and check your subscription.  

Connection Failed. Access 
to network not allowed. 
Please contact your 
Service Provider.  

Contact your service provider to get your roaming 
activated.  

Connection Failed. 
Roaming not allowed. 
Please contact your 
Service Provider.  

 
You couldn’t connect to the network. Wait a few minutes 
and try again. If the problem persists contact your service 
provider.  

Connection Failed. Please 
try again. If the problem 
continues please contact 
your Service Provider.  

Your service provider is not allowing you to access their 
network. Contact your service provider and check you 
have the subscriptions required activated for your SIM.  

Connection Failed. Service 
not supported. Please try 
again. If the problem 
continues please contact 
your Service Provider.  

You couldn’t connect to the network. Wait a few minutes 
and try again. If the problem persists contact your service 
provider.  

Connection Failed. Network 
Problem. Please try again. 
If the problem continues 
please contact your Service 
Provider.  
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Additional Information  

Sony Ericsson Support Web Site  

At www.SonyEricsson.com/support  you can find help and tips in a few clicks. The support 
site gives you access to:  

• the latest software updates  
• tips on how to use your EDGE PC Card efficiently  
• function guides  
• additional help  

 
Guidelines for Safe and Efficient Use  

Please read this information before using your GC82, GC83 or GC85.  

Recommendations  
• Always treat your product with care and keep it in a clean and dust-free place.  
• Do not expose your product to liquid or moisture or humidity.  
• Do not expose your product to extreme high or low temperatures.  
• Do not expose your product to open flames or lit tobacco products.  
• Do not drop, throw or try to bend your product.  
• Do not paint your product.  
• Do not use your product near medical equipment without requesting permission.  
• Do not use your product when in, or around aircraft, or areas posted “turn off two-way 

radio”.  
• Do not use your product in an area where a potentially explosive atmosphere exists.  
• Do not place your product or install wireless equipment in the area above your car’s air 

bag.  
• Do not attempt to disassemble your product. Only Sony Ericsson authorised personnel 

should perform service.  
 
Antenna  

Only use an antenna that has been specifically designed by Sony Ericsson for your 
EDGE PC Card. Use of unauthorised or modified antennas could damage your EDGE PC 
Card and may violate regulations, causing loss of performance and SAR levels above the 
recommended limits (see below).  

Efficient Use  
Do not cover the antenna when in use, as this affects call quality and may cause the 
EDGE PC Card to operate at a higher power level than needed, thus shortening talk and 
standby times.  

 
Radio Frequency (RF) Exposure and SAR  

Your PC Card is a low-power radio transmitter and receiver (transceiver). When it is 
turned on, it emits low levels of radio frequency energy (also known as radio waves or 
radio frequency fields).  

Governments around the world have adopted comprehensive international safety 
guidelines, developed by scientific organizations, e.g. ICNIRP (International Commission 
on Non-Ionizing Radiation Protection) and IEEE (The Institute of Electrical and 
Electronics Engineers Inc.), through periodic and thorough evaluation of scientific studies. 
These guidelines establish permitted levels of radio wave exposure for the general 
population. The levels include a safety margin designed to assure the safety of all 
persons, regardless of age and health, and to account for any variations in 
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measurements.  

Specific Absorption Rate (SAR) is the unit of measurement for the amount of radio 
frequency energy absorbed by the body when using a transceiver. The SAR value is 
determined at the highest certified power level in laboratory conditions, but the actual 
SAR level of the transceiver while operating can be well below this value. This is because 
the transceiver is designed to use the minimum power required to reach the network.  

Variations in SAR below the radio frequency exposure guidelines do not mean that there 
are variations in safety. While there may be differences in SAR levels among mobile 
phones, all Sony Ericsson PC Cards are designed to meet radio frequency exposure 
guidelines.  

Before a PC Card is available for sale to the public, it must be tested and certified to the 
FCC that it does not exceed the limit established by the government-adopted requirement 
for safe exposure. The tests are performed in positions and locations as required by the 
FCC for each model. For body worn operation, this PC Card has been tested and meets 
FCC RF exposure guidelines for fixed and mobile use when the PC Card is installed in a 
PCMCIA card slot of a standard Laptop PC with the original antenna.  

Sony Ericsson has not measured, and makes no representation about, the body worn 
SAR levels when the PC Card is used in any portable host equipment or when any 
changes to the original product has been made.  

More information on radio frequency exposure and SAR can be found on: 
www.sonyericsson.com.  

Personal Medical Devices  
EDGE PC Cards may affect the operation of cardiac pacemakers and other implanted 
equipment. If a minimum distance of 15 cm (6 inches) is kept between the EDGE PC 
Card and the pacemaker, the risk of interference is limited. If you have any reason to 
suspect that interference is taking place, immediately turn off your EDGE PC Card. 
Contact your cardiologist for more information.  

For other medical devices, please consult the manufacturer of the device.  

Children  
DO NOT ALLOW CHILDREN TO PLAY WITH YOUR EDGE PC CARD OR ITS 
ANTENNA. THEY COULD HURT THEMSELVES OR OTHERS, OR COULD 
ACCIDENTALLY DAMAGE THE EDGE PC CARD OR ANTENNA. YOUR EDGE PC 
CARD OR ITS ANTENNA MAY CONTAIN SMALL PARTS THAT COULD BE 
DETACHED AND CREATE A CHOKING HAZARD.  

Disposing of the Product  
Your EDGE PC Card should not be placed in municipal waste. Please check local 
regulations for disposal of electronic products.  

Emergency Calls  
EDGE PC Cards manufactured by Sony Ericsson do not support voice calls, hence 
their use for essential communications (e.g. medical emergencies) is not possible.  

Inserting and removing the SIM card – precautions against electrostatic discharge (ESD)  
Do not touch the SIM card connectors. As a precaution, always make sure that the EDGE 
PC Card is already in your hand before you insert or remove the SIM card.  
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Technical Specifications  

Product 
name  

GC82  GC83  GC85  

System  GSM 850 GSM 1900  
GSM 850 GSM 1800 
GSM 1900  

GSM 900 GSM 1800 
GSM 1900  

Services 
supported  CSD, GPRS/EDGE, 

SMS Speech services 
are not supported  

CSD, GPRS/EDGE, 
SMS Speech services 
are not supported  

*CSD, GPRS/EDGE, 
SMS Speech services 
are not supported  

SIM Card  Small plug-in card, 3V 
type SIM Lock 
supported Regular 
(non-GPRSaware) and 
GPRS-aware SIMs 
supported  

Small plug-in card, 3V 
and 1.8V type SIM 
Lock supported 
Regular (non-
GPRSaware) and 
GPRS-aware SIMs 
supported  

Small plug-in card, 3V 
type SIM Lock 
supported Regular 
(non-GPRSaware) and 
GPRS-aware SIMs 
supported  

Type 
Number  FAA-1041011-BV  

FAF-1031011-BV  FAF-1021011-BV  

 
* feature will be available later, via upgrade  

Exterior Description  

Size  
Battery Antenna  

16-bit PCMCIA PC Card, Type II.  
85.6 mm long x 54.0mm wide x 5.0 mm thick  

 

Weigh 44g including antenna, excluding SIM card  

 

Ambient 
Temper
atures  

Powered via the PC card slot i.e. uses laptop battery  

 

Antenna 50 ohm interface 

 

Temperatures  

Operating -10 to 55 degrees C 

Storage -20 to 65 degrees C 
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Electrical Characteristics  
 

Supported Voltages  3.3V ± 10%  

Nominal Operating Voltage 3.3V 
Average Standby Current/Power (Radio off) < 10mA < 33mW 
Average Idle Current/Power (Attached to 
network)  

< 20mA < 66mW  

 
Data Transfer Current/Power  < 600mA/< 2W< 1A maximum 

instantaneous peak 
 
Operating System Support  

Supported Operating Systems  Microsoft Windows
® 

98 (SE) 

Microsoft Windows
® 

Me Microsoft 

Windows
® 

2000 (SP4) Microsoft 

Windows
®
 XP  

Minimum PC 
Specification 

 

Processor size as recommended 
by Microsoft for the version of 

Windows
®
 in use PC Card slot 30 

MB free disk space  

 

 

GSM Performance and technical characteristics  

Dimension  GSM 850  GSM 900 E-GSM 
900  

GSM 1800  GSM 1900  

Frequency 
Range  

TX: 824 – 849 MHz 
RX: 869 – 894 
MHz  

TX: 880 –914 MHz 
RX: 925 – 959 MHz 

TX: 1710 – 1785 
MHz RX: 1805 – 
1880 MHz  

TX: 1850 – 1910 
MHz RX: 1930 – 
1990 MHz  

Channel 
Spacing  

200 kHz  200 kHz  200 kHz  200 kHz  

Number of 
Channels  

124 Carriers * 8 
(TDMA)  

175 Carriers * 8 
(TDMA)  

374 Carriers * 8 
(TDMA)  

299 Carriers * 8 
(TDMA)  

Modulation  GMSK/8-PSK  GMSK/8-PSK  GMSK/8-PSK  GMSK/8-PSK  

 
Power 
Classes  

Class 4 (2W) for 
GSM/GPRS and 
EGPRS/MCS 1-4 
(GMSK); Class E2 
(0.5W) for 
EGPRS/MCS 5-9 
(8-PSK)  

Class 4 (2W) for 
GSM/GPRS and 
EGPRS/MCS 1-4 
(GMSK); Class E2 
(0.5W) for 
EGPRS/MCS 5-9 
(8-PSK)  

Class 1 (1W) for 
GSM/GPRS and 
EGPRS/MCS 1-4 
(GMSK); Class E2 
(0.4W) for 
EGPRS/MCS 5-9 
(8PSK)  

Class 1 (1W) for 
GSM/GPRS and 
EGPRS/MCS 1-4 
(GMSK); Class E2 
(0.4W) for 
EGPRS/MCS 5-9 
(8PSK)  
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Transmitter 
Output 
Impedance  

50Ω  50Ω  50Ω  50Ω  

Transmitter 
Spurious 
Emission  

According to GSM 
specification  

According to GSM 
specification  

According to GSM 
specification  

According to GSM 
specification  

 

GSM Features Supported ME SIM Lock  

Online Services  View in the Wireless Manager  
(SIM-AT)   

USSD  Support is provided via AT commands; No MMI is provided  

Speech Coding  
 

Not applicable (EDGE PC Card does not support speech 
services)  
 

 

CSD technical data  

Standards AT commands industry standard ETSI 07.05, 
07.07 and 07.10, V.25ter command set supported  

 

CSD Data Rates  9.6 kbps or 14.4 kbps depending on the GSM 
network  

 

Compression  MNP5 (Increases data rate up to 2x depending on 
data type) V.42bis (Increases data rate up to 4x 
depending on data type) GSM network support 
required for compression 

Error Correction  End to End MNP2 and LAPM (V.42) RLP 
Requires GSM Network support  

 

GSM/ISDN  According to V.110 and V.120  

 

 

GPRS technical data  

GPRS Specification SMG  SMG31bis  
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Data Rates   

Multislot class 10 supported (see table below). 
Coding schemes: CS-1, CS-2, CS-3 and CS-4 
 

 

Mode of Operation   
Class B (attaches to both GSM and GPRS at the 
same time; data connection is established using 
CS (CSD or GPRS) The user may select CSD or 
GPRS modes via Dial-Up Networking 

configurations in Windows
® 

 
Attach Modes   

GPRS Attach 
GPRS Detach 
Combined Attach (CS+GPRS) (CCCH) 
Combined Detach (CCCH) 
Combined Attach (CS+GPRS) (PCCCH) 
Combined Detach (PCCCH) 
 

 
 

Network modes  Network Mode 1 Network Mode 2 Network Mode 3  

 

R Reference Point  Physical layer: RS232 virtual COM port 
Authentication mechanisms PAP and CHAP 
supported  

 
IP Connectivity  PDP type IP is supported IPv4, terminated in 

Windows
®
  

 
SMS over GPRS  Mobile Originated and Mobile Terminated  

 
QoS  Support for all 4 classes. QoS Negotiation  

 

PDP Context GPRS Maximum Data Rates  
Up to 10 PDP context details are stored in EDGE 
PC Card  
memory. 
PDP Context description edited via supplied 
Wizard or AT 
command. 
Number of parallel PDP Context activated (both 
MO and  
MT):1 
Number of PDP Context with traffic in parallel:1 
PDP Context modification (e.g. QoS 
renegotiation). 
Network initiated PDP Context modification. 
Network initiated PDP Context deactivation. 
Collision of MS and Network initiated PDP Context 
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activation. 
 

 
SIM  

 

Support for GPRS aware as well as non-GPRS-
aware SIMs  

 

Compression  TCP/IP Header Compression V42bis  

Supported GPRS Frequency  

GPRS IP allocation  
Hopping 

Dynamic Static 

GEA1 GPRS Encryption 

 
 
GPRS Maximum Data Rates  
 
  CS-1 9.05 

kbps  
CS-2 13.4 
kbps  

CS-3 15.6 
kbps  

CS-4 21.4 
kbps  

RX  36.2  53.6  62.4  85.6  4 + 1  

TX  9.05  13.4  15.6  21.4  

RX  27.15  40.2  46.8  64.2  3 + 2  

TX  18.1  26.8  31.2  42.8  

 
Speed achieved depends on the Coding Scheme supported by the GSM Network. The 
speeds given are maximums, Sony Ericsson cannot guarantee how fast your network will 
operate.  

Data rate is the payload per slot: header plus data.  

EDGE Technical Data EDGE Maximum Data Rates  

 

 

Modulation Coding 
Schemes  

MCS-1 to MCS-9 

EDGE features  Link Adaptation 
Incremental Redundancy 

4 + 1  3 + 2  

Coding  Data Rate  Rx  Tx  Rx  Tx  
Scheme  per slot      

MCS-1  10.60  42.40  10.60  31.80  21.20  

MCS-2  13.00  52.00  13.00  39.00  26.00  

MCS-3  16.60  66.40  16.60  49.80  33.20  

MCS-4  19.40  77.60  19.40  58.20  38.80  

MCS-5  24.05  96.20  24.05  72.15  48.10  

MCS-6  31.25  125.00  31.25  93.75  62.50  
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MCS-7  47.45  189.80  47.45  142.35  94.90  

MCS-8  57.05  228.20  57.05  171.15  114.10 

MCS-9  61.85  247.40  61.85  185.55  123.70 
 
Speed achieved depends on the Coding Scheme supported by the GSM Network. The speeds given are 
maximums, Sony Ericsson cannot guarantee how fast your network will operate.  

Data rate is the payload per slot, header plus data.  

 

 

SMS Technical Data 

Concatenated SMS Yes.  

 

SMS Cell Broadcast  Supported in Wireless Manager and by AT 
Commands (excluding Cell ID)  

 

SMS Immediate Display  Supported in Wireless Manager and by AT 
Commands.  

 

SMS interface  Wireless Manager, Communications Suite, pocket 
PC Suite. AT Command  

 

 
 
 

PC Card firmware upgrade  

Software Upgrade  Via Internet, www.sonyericsson.com/support or 
at Sony Ericsson Service Points  

 

PC Communications Suite 
upgrade  

 

Internet download  
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Supported Languages  

 

Product 
support  

GC82 GC83  GC85  

Quick Start 
Guide PC 
Software 
User’s Guide 
(PDF) 

English 
(EN) 
Canadian 
French 
(FR) 
Spanish 
(ES) 

English Canadian 
French (FR) 
Spanish (ES)  

English Danish (DA) Dutch 
(NL) Finnish (FL) French 
(FR) German (DE) Italian (IT) 
Norwegian (NO) Portuguese 
(Brazil) Spanish (ES) 
Swedish (SV) Turkish (TR) 
Chinese Simplified (ZS) 
Chinese Traditional (ZT)  

AT 
Commands 
Manual English English  English  
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License Agreement  

License  
Any use of the enclosed compact disc, diskette or any other media including upgrades 
thereof (“the Software”) shall be in accordance with the below stated license terms and 
conditions. By opening the sealed Software package and/or using the Software you agree 
to be bound by the terms and conditions stated below. These terms and conditions are 
binding and create a legal obligation (the “License Agreement”) between you (the 
“Licensee”) and Sony Ericsson Mobile Communications AB (the “Vendor”).  

The Software licensed hereunder may be delivered in an inseparable package also 
containing other software programs than this particular Software (e.g. bundled with other 
software). As a safeguard you should not in any way use the other software programs 
before reading the specific license terms and conditions of such other software.  

License  

You are hereby granted a non-transferable, non-exclusive right to use (“License”) the 
Software.  

You may only (a) use this Software on one single computer at a time; (b) physically 
transfer the Software from one computer to another if the Software is used only on one 
computer at a time and provided you remove any copies of the Software from the 
computer from which the Software is being transferred and/or on which it was originally 
used; (c) if necessary, make copies of the Software solely for purposes of backup. The 
copyright notice must always be reproduced and included on a label on any backup copy.  

You may not according to the EC Council Directive of May 14, 1991 on the legal 
protection of computer programs (91/250/EEG) (the “Software Directive”) distribute any 
copy of this Software or its documentation to others; nor modify, rent, lease or grant any 
rights to this Software whatsoever to another person or entity. In addition, you may not 
translate, reverse engineer, decompile, disassemble, reproduce or otherwise alter or 
modify the Software, its source code, documentation nor disclose any information 
designated as confidential or proprietary at the time of disclosure or, information which by 
its nature, is confidential or proprietary.  

Term  

Your License remains effective from the date of your cash receipt/proof of payment until 
terminated. You can terminate your License at any time by destroying the Software 
together with all copies of the Software in whichever form they may be. Your License will 
automatically terminate without prior notice if you fail to comply with any term or condition 
of this Agreement. In the event of termination of your License you must immediately 
destroy all copies of the Software in whichever form they may be.  

Limited Warranty  

Sony Ericsson Mobile Communications AB, S-221 88 Lund, Sweden, (Sony Ericsson), 
provides this Limited Warranty for your PC Card and original accessory delivered with 
your PC Card (hereinafter referred to as “Product”).  

Should your Product need warranty service, please return it to the dealer from whom it 
was purchased, or contact your local Sony Ericsson Customer Care Centre (national 
rates may apply) or visit www.SonyEricsson.com to get further information.  

Our Warranty  
Subject to the conditions of this Limited Warranty, Sony Ericsson warrants this Product to 
be free from defects in design, material and workmanship at the time of its original 
purchase by a consumer, and for a subsequent period of one (1) year.  
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What We Will Do  
If, during the warranty period, this Product fails to operate under normal use and service, due 
to defects in design, materials or workmanship, Sony Ericsson authorised distributors or 
service partners, in the country/region* where you purchased the Product, will, at their 
option, either repair or replace the Product in accordance with the terms and conditions 
stipulated herein.  

Sony Ericsson and its service partners reserve the right to charge a handling fee if a returned 
Product is found not to be under warranty according to the conditions below.  

Please note that your personal settings/downloads might be lost when the Product is 
repaired or replaced.  

Conditions  
1 The warranty is valid only if the original proof of purchase issued to the original purchaser 

by an, for this Product, Sony Ericsson authorised dealer, specifying the date of purchase 
and serial number**, is presented with the Product to be repaired or replaced. Sony 
Ericsson reserves the right to refuse warranty service if this information has been 
removed or changed after the original purchase of the Product from the dealer.  

2 If Sony Ericsson repairs or replaces the Product, the repaired or replaced Product shall 
be warranted for the remaining time of the original warranty period or for ninety (90) days 
from the date of repair, whichever is longer. Repair or replacement may involve the use of 
functionally equivalent reconditioned units. Replaced parts or components will become 
the property of Sony Ericsson.  

3 This warranty does not cover any failure of the Product due to normal wear and tear, or 
due to misuse, including but not limited to use in other than the normal and customary 
manner, in accordance with the Sony Ericsson instructions for use and maintenance of 
the Product. Nor does this warranty cover any failure of the Product due to accident, 
software or hardware modification or adjustment, acts of God or damage resulting from 
liquid.  

4 Since the cellular system on which the Product is to operate is provided by a carrier 
independent from Sony Ericsson, Sony Ericsson will not be responsible for the operation, 
availability, coverage, services or range of that system.  

5 This warranty does not cover Product failures caused by installations, modifications, or 
repair or opening of the Product performed by a non-Sony Ericsson authorised person.  

6 The warranty does not cover Product failures which have been caused by use of 
accessories or other peripheral devices which are not Ericsson or Sony Ericsson branded 
original accessories intended for use with the Product.  

7 Tampering with any of the seals on the Product will void the warranty.  
8 THERE ARE NO EXPRESS WARRANTIES, WHETHER WRITTEN OR ORAL, OTHER 

THAN THIS PRINTED LIMITED WARRANTY. ALL IMPLIED WARRANTIES, 
INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED TO 
THE DURATION OF THIS LIMITED WARRANTY. IN NO EVENT SHALL SONY 
ERICSSON OR ITS LICENSORS BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL 
DAMAGES OF ANY NATURE WHATSOEVER, INCLUDING BUT NOT LIMITED TO 
LOST PROFITS OR COMMERCIAL LOSS, TO THE FULL EXTENT THOSE DAMAGES 
CAN BE DISCLAIMED BY LAW.  

 
Some countries/states do not allow the exclusion or limitation of incidental or 
consequential damages, or limitation of the duration of implied warranties, so the 
preceding limitations or exclusions may not apply to you.  

The warranty provided does not affect the consumer's statutory rights under applicable 
legislation in force, nor the consumer's rights against the dealer arising from their sales/ 
purchase contract.  

* European Union (EU)  
If you have purchased your Product in an EU country you can have your Product 
serviced, under the conditions set out above, within the warranty period in any EU country 
where an identical Product is sold by an authorised Sony Ericsson distributor. To find out 
if your Product is sold in the EU country you are in, please call the local Sony Ericsson 
Customer Care Centre. Please observe that certain services may not be possible 
elsewhere than in the country of original purchase, for example due to the fact that your 
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Product may have an interior or exterior which is different from equivalent models sold in 
other EU countries. It may not be possible to repair SIM-locked Products.  

** In some countries/regions additional information is requested. If so, this is clearly 
shown on the valid proof of purchase.  

Vendor warrants the media on which the Software is provided, to be free from defects in 
materials and workmanship under normal use for ninety (90) days after the date of your 
cash receipt/proof of payment. The Vendor's and its suppliers' entire liability and your 
exclusive remedy under this warranty will at Vendor's option be (and provided you return 
the Software to an authorized reseller/ supplier together with a copy of your cash 
receipt/proof of payment), to replace the disc(s)/ diskette(s) or refund the purchase price 
and terminate this Agreement including the License.  

Except for the above express limited warranties, Vendor and its suppliers do not provide 
nor do you receive any warranties or conditions whether express, implied, statutory or 
otherwise and Vendor and its suppliers specifically disclaim any implied warranties of 
satisfactory quality and/or fitness for a particular purpose. If your jurisdiction does not 
allow limitations on implied warranties to consumers, the above limitation may not apply 
to you.  

Vendor does not warrant that your use of the Software will be uninterrupted or error free. 
You assume full responsibility for the selection of this Software and your selected 
hardware and for the Software and hardware together achieving your intended results, as 
well as for any installation or use of or result obtained from the Software.  

Intended use  

The Software shall be used in accordance with the instructions and for its intended use 
and purpose only. The Software or part thereof may not be used in e.g. life support 
systems, nuclear facility applications, nor for the purposes of missile technology, 
chemical or biologized industry, flight navigation or communication of air, ground support 
equipment or other similar business or for any other purpose where any failure by the 
Software to perform may result in personal injury, death, damage to tangibles or the 
environment.  

Limitation of liability  

In no event shall Vendor or its suppliers be liable for any indirect or consequential losses 
or damages whatsoever irrespective of the cause for such losses or damages, including 
loss of data, loss of business profits or revenue, or any business interruption arising out of 
the use of or inability to use this Software. Vendor and its suppliers' total liability under 
this Agreement shall be limited to the amount actually paid by Licensee for the Software.  

Disputes and Governing Law  

The validity, construction and performance of this Agreement shall be governed by the 
laws of Sweden. All disputes, differences or questions between the parties with respect to 
any matter arising out of or relating to this Agreement shall be finally settled under the 
Rules of Conciliation and Arbitration of the International Chamber of Commerce, in 
Stockholm, by three (3) arbitrators appointed in accordance with the said Rules. The 
proceeding shall be conducted in the English language.  
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Declaration of Conformity 
 
Declaration of Conformity  

We, Sony Ericsson Mobile Communications AB of 

Nya Vattentornet 

S-221 88 Lund, Sweden 

 

declare under our sole responsibility that our product,  

Sony Ericsson type FAF-1031011-BV,  

and in combination with our accessories, to which this declaration relates is in conformity 
with the appropriate standards 3GPP TS 51.010-1, EN 301489-7 and EN 60950, 
following the provisions of, Radio Equipment and Telecommunication Terminal 
Equipment directive 99/5/EC with requirements covering EMC directive 89/336/EEC, and 
Low voltage directive 73/23/EEC.  

 0682 
 

Research Triangle Park NC, May 2004 

Place and date of issue  

 
Anders Franzén  

Corporate Vice President M2M Com  

We fulfil the requirements of the R& TTE Directive (99/5/EC). 
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FCC Statement          

                                                                                                                                          

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:  

• (1) This device may not cause harmful interference, and  
• (2) The device must accept any interference received, including interference that may cause 

undesired operation.  
 

GC82 PC Card:  

FCC-ID: PY7F1041011 

IC: 4170B- F1041011  
 
GC83  

FCC-ID: PY7FF031011 

 IC: 4170B- FF031011  
 
GC85 

FCC-ID: PY7FF021011 

IC: 4170B- FF021011  
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Appendix A - Connection Parameters  

General Connection Parameters for CSD and GPRS CSD Specific Parameters  

Required  Useful information  

Telephone 
number or 
Access Point 
Name (APN)  

Number you need to dial to reach your service provider. Use the full 
number including country code and area code, e.g. +46 33 555 
2525. Or The APN server resource to contact, for example, 
Interent.operator.net - to connect to the Internet via the mobile 
operator’s or your corporate Intranet via a VPN.  

You will need to know the bearer capability provided by your 
service provider, so you can select the appropriate option during 
set up.  

Bearer 
capability: CSD 
or GPRS?  

CSD Network 
Speed  

If you intend to create connections via CSD contact your network 
operator and check the supported speeds.  

Username  The username your service provider gave you when the account 
was set up. Some dial-up accounts do not require a Username, in 
this case leave the field blank.  

Password  Password associated with the username, given to you by the 
service provider. Some dial-up accounts do not require a 
Password, in this case leave the field blank.  

IP assignment: 
Server / Static  

An ‘address’ that the service provider knows you by and uses to 
route information to and from your EDGE PC Card. Your IP address 
will either be: Server - assigned by the service provider when you 
connect. Static - assigned once by the service provider or the IT 
Manager. If your IP address is Static you must enter it into Own IP 
address fields which is available when you select Details in the 
Connection APN dialog.  

DNS 
assignment: 
Server / Static  

This tells the EDGE PC Card where to find the service provider’s 
DNS Service. DNS translates addresses such as 
www.sonyericsson.com to the numeric IP address so that the 
information can be accessed. Like IP assignment above, the DNS 
can be static or allocated by the service provider when you connect. 
If static is selected additional fields need to be completed 
containing the static information. 

 
Own IP address  

Only required if the IP assignment is static. Format example: 
123.9.45.3. Do not enter any leading 0s when typing in IP address.  

Primary DNS  Only required if the DNS assignment is static. Format 
example:123.9.45.2  

Secondary DNS  Only required if the DNS assignment is static. Format example: 
123.9.45.1  

Access Point 
Name (APN)  

If the APN is set to default you will have to enter the name of the 
access point your network operator is using.  

 

Required  Useful information  

Preferred 
Connection 
Speed (bits/s)  

Select your preferred network connection speed from the drop 
down list provided: 9600 or14400.  

Connection 
Mode  Select the method you want to use to connect to the network from 

the options provided: analogue, ISDN V.110 or ISDN V.120  
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Compression  Use to speed up data transfer. You can select to Enable Data 
Compression and Header Compression.  

Callback Number  Enter the number the a callback should be made to. You can only 
use Callback if you are connecting to a source that gives 
permission for callbacks to be made, for example your company 
server.  

 
TCP/IP Optimisation  

To take full advantage of the high bandwidth of the PC Card, the TCP/IP window size 
parameter TCPWindowSize should be changed from the default Windows setting of 16k 
for Windows 2000, or 64k for Windows XP. Sony Ericsson recommends a TCP/IP packet 
size of 43200 for optimum performance with the PC Card. An MTU size of 1450 is also 
considered optimal for EDGE networks.  

These settings are made automatically when the Wireless Manager is installed. They may 
be viewed and, if necessary, changed in the properties of the Sony Ericsson Wireless 
WAN network adaptor.  

Select Start   Settings   Network and Dial-up Connections, locate the Sony Ericsson 
Wireless WAN adaptor in the list, right-click on it and select Properties.  

 
Click Configure on the Advanced tab. If directed by your network operator, you may 
change the settings by selecting TCPWindowSize or MTU and changing the value. 
Changes to these settings require the network adaptor to be restarted. It is 
recommended that the laptop is rebooted.  

 
If you have previously optimised TCPWindowSize, for example as directed by a broadband internet 
service provider, then check whether that setting is global or specific to the network adaptor over which 
the broadband connection is made. It is preferable that all TCPWindowSize settings are specific to the 
network adaptor involved, since this ensures that each individual connection is correctly optimised.  

In some cases it is necessary to set TCPWindowSize globally. Further information and a utility to do this 
is available at www.sonyericsson.com/support.  
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Glossary  

Bearer  

Path over which data flows. Specifically in CSD the type of telephony link from the GSM network to the 
server - V PSTN or ISDN.  

bps  

Bits per second - rate of data flow.  

COM Port  

Defines a serial/RS-232 port within the Windows
® 

environment. May be physical (COM1 port on the rear 
of the PC) or virtual (COM5 port communicating with a PC card modem)  

CS  

Circuit Switched. Connection from A to B which has a fixed bandwidth and is maintained over a period of 
time, for example a voice telephone call.  

CS-1 to CS-4  

Coding Scheme. Determines the data rate per timeslot in GPRS.  

CSD  

Circuit Switched Data. CSD is a GSM service providing a CS data connection at a rate of 9.6 or 14.4 
kbps.  

DUN  

Dial-Up Networking.  

EDGE  

Enhanced Data rates for Global Evolution.  

e-GSM  

Extended GSM. New frequencies specified by the European Radio Communications Committee (ERC) 
for GSM use when additional spectrum is needed (Network dependent). It allows operators to transmit 
and receive just outside GSM’s core 900 frequency band. This extension gives increased network 
capability.  

ETSI  

European Telecommunications Standards Institute. www.etsi.org 
 

GGSN  

Gateway GPRS Support Node.  

GPRS  

General Packet Radio Services.  

GSM  

Global System for Mobile Communications. GSM is the world’s most widely-used digital mobile phone 
system, now operating in over 160 countries around the world.  

GSM 900  

The GSM system family includes GSM 900, GSM 1800 and GSM 1900. There are different phases of roll-
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out for the GSM system and GSM phones are either phase 1 or phase 2 compliant.  

GSM 1800  

Also known as DCS 1800 or PCN, this is a GSM digital network working on a frequency of 1800 MHz. It is 
used in Europe and Asia-Pacific.  

GSM 1900  

Also known as PCS. Refers to a GSM system running in the 1900MHz band. Used in the USA and 
Canada, for instance.  

HTML  

Hyper Text Markup Language.  

HTTP  

Hyper Text Transfer Protocol.  

ISDN  

Integrated Services Digital Network. Can provide circuit-switched data connections in multiples of 
64 kbps.  

ISP  

Internet Service Provider.  

kbps  

Kilobits per second - rate of data flow.  
 
LAN  

Local Area Network.  

ME  

Mobile Equipment.  

MO  

Mobile Origination. For example, an SMS message sent from a mobile terminal.  

MMI  

Man-Machine Interface.  

MS  

Mobile Station.  

MT  

Mobile Termination.  

PC  

Personal Computer.  

PCS  

Personal Communications Services, often used to describe GSM1900 networks.  

PC Card  

A card having physical and electrical characteristics specified by PCMCIA providing extra functionality 
when inserted into a laptop PC. Typical examples are modems and network cards. Type refers to the 
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thickness of the card. The EDGE PC Card is type II.  

PCMCIA  

Personal Computer Memory Card International Association – defines specifications for PC Cards. 
www.pcmcia.org. 

PDP  

Packet Data Protocol.  

Phone book  

A memory in the SIM card where phone numbers can be stored and accessed by name or position.  
 

PSTN  

Public Switched Telephone Network, for example ordinary analogue phone line for speech and/or 
computer modem.  

RADIUS  

Remote Access Dial-In Service. Facility at the ISP or corporation to manage remote data connections.  

RX  

Receive  

SC  

Service Centre (for SMS).  

Service Provider  

A company that provides services and subscriptions to EDGE PC Card users.  

SIM card  

Subscriber Identity Module card – a card that must be inserted in any GSM-based mobile terminal. It 
contains subscriber details, security information and memory for a personal directory of numbers. The 
card can be a small plug-in type or credit card-sized, but both types have the same functions. The EDGE 
PC Card uses the small plug-in card.  

SMS  

Short Message Service. Allows messages of up to 160 characters to be sent and received via the 
network operator's message centre to a EDGE PC Card.  

TCP/IP  

Transmission Control Protocol/Internet Protocol.  

TCP/IPv4  

TCP/IP Version 4. Most widely implemented form of TCP/IP today having a 4 byte address format such 
as  
212.161.127.136.  

TE  

Terminal Equipment. Generic term for GSM terminals such as phones and PC cards.  

Terminal Adaptor  

Generic term for the equipment terminating a digital comms line such as an ISDN2 line. The EDGE PC 
Card is a Terminal Adaptor since it interfaces to GSM digital data services.  
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TLS  

Transport Layer Security. Used by Web browsers, for example.  

TX  

Transmit  

Type II  

Refers to thickness of a PC Card as defined in the specification from PCMCIA.  

URL  

Uniform Resource Locator.  

USSD  

Unstructured Supplementary Services Data. Narrow-band GSM data service. For example entering 
*79*1234# might return the stock price for stock 1234.  

V.110  

ETSI standard for data over an ISDN circuit.  

V.120  

ETSI standard for data over an ISDN circuit.  

VPN  

Virtual Private Network.  

WWW  

World Wide Web.  

XML  

Extensible Markup Language.  
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